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Introduction

Target Audience

This guide is designed for system administrators who are planning to administer Adobe® Creative
Suite® 5 or 5.5 (CS5 or CS5.5) with the Casper Suite.

What’s in This Guide

This guide provides step-by-step instructions for deploying, serializing, reporting on, and updating
Adobe CS5 or CS5.5 with the Casper Suite.

Important Concepts

Administrators using this guide should be familiar with the following Casper Suite-related
concepts:

« Package and script management

«  Deployment

« Licensed software reporting

« Application usage reporting

«  Smart computer groups

Additional Resources

For more information on applications, concepts, and processes related to the Casper Suite,
download the Casper Suite Administrator’s Guide from:

http://jamfsoftware.com/resources/documentation

For more information from Adobe on packaging, deploying, and updating Adobe CS5 and CS5.5,
download Adobe’s CS5/5.5 Enterprise Deployment Guide from:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html
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Overview

The Casper Suite provides a complete solution to administering Adobe products in the enterprise.
In the past, Mac administrators have used the Casper Suite in combination with the Adobe
Application Manager Enterprise Edition (AAMEE) to administer Adobe CS5. With the releases

of Adobe CS5.5 and AAMEE version 2.0 comes the demand for an updated solution. A similar
workflow can now be used to administer CS5 or CS5.5 using the Casper Suite and AAMEE 2.0.

Using this workflow, administrators can package and provision Adobe CS5 or CS5.5 for
deployment. They can also automate Adobe’s custom serialization method by deploying the
Adobe command-line tool along with a serialization script. Coupled with the Casper Suite’s
reporting capabilities, serialization can help administrators deploy and track product licenses more
effectively.

Mac administrators also have more options when deploying Adobe CS5 or CS5.5 updates with the
Casper Suite. In addition to deploying Adobe updates using Adobe’s silent installation technology,
updates can be installed as they become available by setting up and deploying an internal Adobe
update server.



Requirements

To administer Adobe CS5 or CS5.5 using the instructions in this guide, you need:

Adobe Application Manager Enterprise Edition (AAMEE) 2.0 for Mac
Adobe Provisioning Toolkit Enterprise Edition for Mac

Adobe CS5 or CS5.5 installer media

The Casper Suite v7.3 or later running in your environment

Access to the JAMF Software Server (JSS)

Casper Admin

Composer

(Optional) A server for the Adobe update server

(Optional) Adobe Update Server Setup Tool (AUSST) 2.0 for Mac

All Adobe Creative Suite deployment tools are available at:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html
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Deploying Adobe CS5 or CS5.5

This section explains how to deploy Adobe CS5 or CS5.5 with the Casper Suite.

Note: These instructions apply to Adobe CS5 and CS5.5 only. For instructions on how to deploy
Adobe CS3 or CS4, see the Casper Suite Administrator’s Guide.

Creating a CS5/5.5 Deployment Package

The first step to deploying Adobe CS5 or CS5.5 is to create a deployment package using Adobe’s
custom enterprise deployment tool, AAMEE 2.0.

Before you begin, review the package creation requirements in Adobe’s C55/5.5 Enterprise
Deployment Guide. This guide is available at:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

To create a CS5/5.5 deployment package:

If you do not have AAMEE 2.0, download it from:
http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

Double-click the Adobe Application Manager folder and open the Install program.
Enter the password for a local account and then click OK.
Follow the instructions in the “Creating Deployment Packages” section of Adobe’s CS5/CS5.5

Enterprise Deployment Guide to create the package.
JAMF Software makes the following recommendations:

« Ifyou are installing CS5.5, include Acrobat® X Pro in the installation since AAMEE 2.0 supports
this. If you need to install Acrobat X Pro separately, see the “Administering Adobe Acrobat X
Pro with the Casper Suite” technical paper for detailed instructions. This paper is available at:

http://www.jamfsoftware.com/resources/white-papers

Note: To package Acrobat X Pro using the AAMEE tool, one or more CS5.5 applications must be
included in the package.
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- Configure the deployment package to disable Adobe AIR® components. You can do this on the
Configure Package pane.

Deployment packages with AIR enabled can only be installed during imaging, from Self
Service, or with a policy triggered by login. Disabling the AIR components allows you to install
the package at any time. See the “Installing Products in the Exceptions Folder” section for more
information about installing AIR separately.

« Configure the deployment package to ignore conflicting processes.

You can do this on the Configure Package pane by selecting the Ignore conflicts and continue
with installation option.

Note: AAMEE 2.0 automatically detects any available updates for the products in the deployment
package and applies them. This ensures that you are deploying the most up-to-date versions

of the products. To install an update-only package, refer to the “Updating Adobe CS5 or CS5.5”
section.

When you are finished creating the deployment package, an AAMEE-created folder that contains
a Build folder and an Exceptions folder is created in the location where you chose to save it. The
Build folder contains two PKGs: the deployment package and an uninstall package.

Uploading the Deployment Package

After creating the deployment package, upload it to the JSS using Casper Admin.

To upload the deployment package:

Open Casper Admin.

Log in using credentials for a JSS administrator account.
Locate and open the AAMEE-created folder.

Open the Build folder and locate the deployment package.

Drag the deployment package to the Package pane in Casper Admin.
The package may take a few minutes to upload depending on its size.

Double-click the deployment package.

In the Information pane that appears, click the Info tab and choose a category from the Category
pop-up menu.

Click the Options tab and choose a priority from the Priority pop-up menu.

The recommended priority for the deployment package is “10”. For more information on priorities,
see the “Changing Package Attributes” section in the Casper Suite Administrator’s Guide.

Configure additional settings as needed and then click OK.

Save your changes and quit the application.




Deploying the Deployment Package

There are several ways to deploy the deployment package:

« Using a policy

« Using Casper Remote

«  During imaging

«  Using Self Service

This guide includes instructions for the first three methods. For instructions on the Self

Service method, see the “Making Policies Available in Self Service” section of the Casper Suite
Administrator’s Guide.

Note: Adobe CS5/5.5 packages that were created using the AAMEE tool cannot be deployed
using the instructions in this guide if your master distribution point is an SMB share. For more
information, refer to the following Knowledge Base article:

http://jamfsoftware.com/kb/article.php?id=305

To deploy the deployment package using a policy:
Log in to the JSS with a web browser.

Click the Management tab.

Click the Policies link.

Click the Create Policy button.

Select the Install or uninstall a package option and then click Continue.

Policy A _

Tasks
@

What do you want to do?

" @ Install or uninstall a package

“ (O Add or remove a printer

- ) Run a script

£, © create policy manually

Follow the onscreen instructions to configure the rest of the policy.

If you chose to leave Adobe AIR components enabled when you created the deployment package,
you must set the trigger as “login” or “Self Service”.

Computers in the scope execute the policy the next time they check in with the JSS.
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To deploy the deployment package using Casper Remote:
Open Casper Remote.
Log in using credentials for a JSS administrator account.

On the Computers tab, locate the computers that you want to receive the deployment and select
the checkbox next to each one.

Click the Packages tab.
Locate the deployment package in the Packages list and select the checkbox next to it.

Click Go to initiate the deployment.

eno Casper Remote (1 Computer Selected) (e}

ot ; . -
L) nY [ Fiter Packages
NewWindow  Screen Share  Override Defaults Refresh Data
Tasks
‘@ Install Adobe C55.5 ( \
Computers | Packages | Scripts  Printers  Dock  Accounts = Reboot  Advanced
Selected Computers
B ENGL-CSG-147 Packages - 1 Selected
Software
@ Adobe CS5.5
No Description
Adobe C55.5
Action: [ Install B Fill User Templates Fill Existing Users [ Update Autorun

All Cached Packages Software Update

I Install All Cached Packages (] set Server [ install all updates

((saveas... ) (Schedue.) (G )
A

When the process is complete, quit the application.

The package is immediately deployed to target computers.

To deploy the deployment package during imaging:
Open Casper Admin.

Log in using credentials for a JSS administrator account.
Double-click the deployment package in the repository.

In the Information pane that appears, click the Options tab.

Select the This package must be installed to the boot volume at imaging time checkbox and
click OK.

Drag the deployment package from the Package pane to a configuration in the sidebar.

Save your changes and quit the application.

The package is deployed the next time you use the configuration to image computers.



Installing Products in the Exceptions Folder

Any components that you chose to disable during the creation of the deployment package, such
as Adobe AIR, are stored in an Exceptions folder. The Exceptions folder is located in the AAMEE-
created folder on the computer that you used to create the deployment package.

After deploying the deployment package, you can install the products that are in the Exceptions
folder as desired.

Installing products in the Exceptions folder involves the following steps:
Create an Exceptions folder package.

Create the install script(s).

Upload the Exceptions folder package and the install script(s) to the JSS.

Create a policy to install products that are in the Exceptions folder.

Creating an Exceptions Folder Package

The first step to installing products that are in the Exceptions folder is to create a package of the
folder using Composer.

To create an Exceptions folder package:

Create a folder called “AdobeExceptions”in the following location:
/Library/Application Support/JAMF/

Move the Exceptions folder from the AAMEE-created folder to the following location:
/Library/Application Support/JAMF/AdobeExceptions/

Open Composer and authenticate locally.

Drag the Exceptions folder to the Sources list in Composer.
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When Composer is finished creating the package source, click the Build as DMG button.

ne e Composer =)
0 ﬁ (T
u N Q-
NewPackage  Reveal In Finder Quick Look Delete Search
SOURCES » (& Library

= Exceptions.
PACKAGES

wl=la)

When prompted, save the package in the desired location.

When Composer is finished building the package, quit the application.

Creating the Install Script(s)

Use the commands provided in “Installing Products in the Exceptions Folder” section of the C55/5.5
Enterprise Deployment Guide to create an install script for each product that you want to install.

To create an install script:
Open a text editor.

From the menu bar, navigate to Format > Make Plain Text.

Type the deployment commands. For example, if you are installing Adobe AIR, the deployment
command would look like this:

launchctl bsexec “ps auwwx Igrep [1]oginwindow | awk '{ print $2 }'"
/Library/Application\ Support/JAMF/AdobeExceptions/Exceptions/
Adobe\ AIR\ Installer.app/Contents/Mac0S/Adobe\ AIR\ Installer -
silent

Save the script as a Bash Shell Script file with the . sh file extension.

Quit the application.

Uploading the Exceptions Folder Package and the Install Script(s)

After creating both the Exceptions folder package and the install script(s), upload them to the JSS
using Casper Admin.

12
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To upload the Exceptions folder package and the install script(s):
Open Casper Admin.
Log in using credentials for a JSS administrator account.

Drag the Exceptions folder package and the install script(s) to the Package pane in Casper Admin.
The package may take a few minutes to upload depending on its size.

When the upload is complete, drag the package and script(s) into a category.
Double-click the install script.

In the Information pane that appears, click the Options tab.

Choose "After” from the Priority pop-up menu and then click OK.

Repeat steps 5 through 7 for each install script.

Save your changes and quit the application.

Creating a Policy to Install the Exceptions Folder Package

Use the policy framework to install the Exceptions folder package and run the install script(s) on
target computers.

To create a policy to install the Exceptions folder package:

Log in to the JSS with a web browser.

Click the Management tab.

Click the Policies link.

Click the Create Policy button.

Select the Install or Uninstall a Package option and then click Continue.
Enter the name of the Exceptions folder package and then click Continue.

Follow the onscreen instructions to complete the rest of the Policy Assistant.
Set the trigger as “login” or “Self Service” and the execution frequency as “Once Per Computer”.
You will add the install script(s) using the manual policy interface in the next few steps.

On the Conclusion pane, verify that the name of the policy is correct and then click Edit Manually.

Click the Scripts tab.

Click the Add Script link.

Select the Run option next to each install script.
Click the Add Scripts button.

Click the Save button.

Computers in the scope execute the policy the next time they check in with the JSS.

13



Serializing Adobe CS5 or CS5.5

Managing the serialization of Adobe CS5/5.5 products starts with the Adobe Provisioning Toolkit, a
command-line tool from Adobe. This tool allows you to serialize Adobe CS5/5.5 products after they
are deployed.

Post-deployment serialization allows you to distribute licenses more effectively by activating only
the products that a user needs on a given computer.

Serializing Adobe CS5/5.5 products involves the following steps:

Create an Adobe Provisioning Toolkit package.

Create the serialization script(s).

Upload the Adobe Provisioning Toolkit package and the serialization script(s) to the JSS.

Create a policy to serialize Adobe CS5/5.5 products.

Note: This workflow is intended for Adobe CS5/5.5 products that were packaged using AAMEE
2.0.

Creating an Adobe Provisioning Toolkit Package

The first step to serializing Adobe CS5/5.5 products is to create a package of the Adobe
Provisioning Toolkit using Composer.

To create an Adobe Provisioning Toolkit package:

If you do not have the Adobe Provisioning Toolkit, download it from:

http://www.adobe.com/devnet/creativesuite/enterprisedeployment.html

Move the Adobe Provisioning Toolkit (adobe_prtk) to the following location:
/Library/Application Support/JAMF/

Open Composer and authenticate locally.

Drag the adobe_prtk binary file to the Sources list in Composer.

14
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When Composer is finished creating the package source, click the Build as DMG button.

008 Composer
'_A“, Lo (Q-
New Package  Reveal In Finder Quick Look Delete Search
SOURCES v {3 Library
» w adobe_prtk v (i Application Support

PACKAGES v [ )AmF
M adobe_prtk

[ Build as DMG | | Build as PKG |
Bul’d a5 DMG. /]Il Builc.as PKG.

When prompted, save the package in the desired location.

When Composer is finished building the package, quit the application.

Creating the Serialization Script(s)

Use the commands, tool syntax, and product identification information in “Using the Adobe
Provisioning Toolkit Enterprise Edition” section of the C55/5.5 Enterprise Deployment Guide to create
a serialization script for each product.

Each script must include the following information:
«  The location of the adobe_prtk binary file

- Serialization commands

To create a serialization script:
Open a text editor.
From the menu bar, navigate to Format > Make Plain Text.

Enter the pathname to the adobe_prtk binary file followed by the serialization commands. For
example, a script to serialize Adobe Photoshop® CS5/5.5 would look like this:

/Library/Application\ Support/JAMF/adobe_prtk --tool=ReplaceSN
--serialize=Photoshop-CS5-Mac-GM --serial=XXXX-XXXX-XXXX-XXXX-
XXXX-XXXX

Save the script as a Bash Shell Script file with the . sh file extension.

Quit the application.

15



Uploading the Adobe Provisioning Toolkit Package and
the Serialization Script(s)

After creating the Adobe Provisioning Toolkit package and the serialization script(s), upload them
to the JSS using Casper Admin.

To upload the Adobe Provisioning Toolkit package and the serialization script(s):
Open Casper Admin.
Log in using credentials for a JSS administrator account.

Drag the Adobe Provisioning Toolkit package and the serialization script(s) to the Package panein
Casper Admin.

The package may take a few minutes to upload depending on its size.
When the upload is complete, drag the package and script(s) into a category.
Double-click the serialization script.

In the Information pane that appears, click the Options tab.

s Information for adobe_prtk.sh

m Info | Options |

Display Name: adobe_prtk.sh

File Name: adobe_prtk.sh

Category: Unknown | Revealin Finder |
Kind: Script Format: Shell Script
Size: n/a Priority: After
Date Created: 7/11/11 ar 11:24 AM User Templates: n/a
Date Modified: 7/11/11 at 11:24 AM Existing Users: n/a
JSSID: 1 Reboot Required: n/a
Executable: No Stage: Deployable

Computers that have a package receipt for this: n/a
Configurations that this is a member of: 0

Computers that use this for autorunning: nfa

| Previous | | MNext | | Cancel | [ ok |

Choose “After” from the Priority pop-up menu and then click OK.

Save your changes and quit the application.
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Creating a Policy to Serialize Adobe CS5/5.5 Products

Use the policy framework to install the Adobe Provisioning Toolkit package and run the
serialization script(s) on target computers.

To create a policy to serialize Adobe CS5/5.5 products:

Log in to the JSS with a web browser.

Click the Management tab.

Click the Policies link.

Click the Create Policy button.

Select the Install or uninstall a package option and then click Continue.

Enter the name of the Adobe Provisioning Toolkit package and then click Continue.

Follow the onscreen instructions to complete the rest of the Policy Assistant.
Set the trigger as “every15” and the execution frequency as“Once per computer”.
You will add the script(s) using the manual policy interface in the next few steps.

On the Conclusion pane, verify that the name of the policy is correct and then click Edit Manually.

Click the Scripts tab.

Click the Add Script link.

Select the Run option next to each serialization script.
Click the Add Scripts button.

Click the Save button.

Computers in the scope execute the policy the next time they check in with the JSS.

17
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Reporting on Adobe CS5 or CS5.5

After deploying Adobe CS5 or CS5.5, you can use the Casper Suite to track Adobe CS5/5.5 licenses
and report on how often they are used. You can use this information to remediate clients that do
not have Adobe CS5 or CS5.5 products installed and retrieve unused licenses.

Reporting on Adobe CS5/5.5 involves the following steps:
Create a licensed software record.

Update inventory in the JSS.

Generate a Licensed Software report.

Generate an Application Usage report.

Create a smart computer group.

Creating a Licensed Software Record

Licensed software records allow you to store licensing information in the JSS. These records can
include the number of licenses owned, serial number(s), and purchasing details.

Licensed software templates for Adobe CS5/5.5 are built right into the JSS, allowing you to create
licensed software records quickly and easily.

Note: The licensed software template for Adobe CS5.5 is only available in the Casper Suite 8.21
and later.

To create a licensed software record:
Log in to the JSS using a web browser.
Click the Settings tab.
Click the Licensed Software Management link.

Click the Licensed Software from Template button.

18



5. Click the Create link across from the Adobe CS5/5.5 product.

Licensed Software Record from Template

Search Licensed Software Templates: |
Name Publisher Platform
Adobe Acrobat 6.0 Professional Adobe Systems Incorporated mac Create
Adobe Acrobat 7.0 Professional Adobe Systems Incorporated mac Create
Adobe Acrobat 9.0 Professional Adobe Systems Incorporated mac Create
Adobe Creative Suite 1 - Standard Edition Adobe Systems Incorporated mac Create
Adobe Creative Suite 1 - Premium Edition Adobe Systems Incorporated mac Create
Adobe Creative Suite 2 - Standard Edition Adobe Systems Incorporated mac Create
Adobe Creative Suite 2 - Premium Edition Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Design Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Design Standard Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Master Collection Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Production Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Web Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 3 - Web Standard Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Design Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Design Premium Adobe Systems Incorporated windows  Create
Adobe Creative Suite 4 - Design Standard Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Design Standard Adobe Systems Incorporated windows  Create
Adobe Creative Suite 4 - Master Collection Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Master Collection Adobe Systems Incorporated windows  Create
Adobe Creative Suite 4 - Production Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Production Premium Adobe Systems Incorporated windows  Create
Adobe Creative Suite 4 - Web Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Web Premium Adobe Systems Incorporated windows | Create
Adobe Creative Suite 4 - Web Standard Adobe Systems Incorporated mac Create
Adobe Creative Suite 4 - Web Standard Adobe Systems Incorporated windows  Create
Adobe Creative Suite 5 - Design Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 5 - Design Standard Adobe Systems Incorporated mac Create
Adobe Creative Suite 5 - Master Collection Adobe Systems Incorporated mac Create
Adobe Creative Suite 5 - Production Premium Adobe Systems Incorporated mac Create
Adobe Creative Suite 5 - Web Premium Adobe Systems Incorporated mac Create

6. Click the Licenses tab and click Add License.

7. Inthe Serial Number 1 and Serial Number 2 fields, enter serial number(s) for the product as
needed.

Edit Licensed Software: Adobe Creative Suite 5 - Design Premium

e = 7\

Info Licenses Software Definitions

License Info

Serial Number 1:

Serial Number 2:

Organization Name:

Registered To:
License For: ® o Licenses
(8] Concurrent Licenses
() site License
Notes:

Purchasing Info

Perpetual License ® Annual License ()
PO Number: | PO Date: / /
vendor: | License Expires: ! /
Purchase Price: | Life Expectancy:

8. Make sure that the Licenses For option is selected and enter the number of licenses in the
Licenses field.

9. Click the Store License button.

10. Click the Software Definitions tab and verify that all products deployed in your licensed version of
CS5 or CS5.5 are listed.



11. Click the Save button.

Edit Licensed Software: Adobe Creative Suite 5 - Design Premium

i ] 5] A
Info Licenses Software Definitions
Application Name Version
Adobe Dreamweaver C55.app like 11. Edit... Remove...
Adobe Fireworks C55.app like 11. Edit... Remove...
Adobe Flash CS5.app like 11. Edit... Remove. .
Adobe Flash Builder 4.app like 4. Edit... Remove...
Adobe Flash Catalyst C55.app like 1. Edit... Remave...
Adobe Illustrator.app like Edit... Remove...
Adobe InDesign CS5.app like 7. Edit... Remove. .
Adobe Photoshop CS5.app like 12. Edit... Remove...

Add Application...
Font Name Version
There are no Fonts entered
Add Font...
Plugin Name Version
There are no Plugins entered

Add Plugin...

Updating Inventory

The JSS must contain up-to-date inventory information to generate accurate reports. Although
computers automatically submit updated inventory reports to the JSS according to the set
frequency, you may want to generate inventory reports on the fly. You can do this using Casper
Remote.

To update inventory using Casper Remote:
1. Open Casper Remote.

2. Login using credentials for a JSS administrator account.

3. Onthe Computers tab, select the checkbox next to each computer that has Adobe CS5/5.5
products installed.

4. Click the Advanced tab.

5. Select the Update Inventory checkbox.

20



Click the Go button to initiate the update.

800 Casper Remote (1 Computer Selected) =

= Tasks
|| Update Inventory
* Selected Computers
B ENGL-CSG-147

[ Computers  Packages | Scripts  Printers | Dock  Accounts  Reboot | Advanced |

[ Update Inventory (Recon) [ Update Prebindings (] Flush System Caches
) Reset Computer Names [ Fix Permissions. | Flush User Caches
] Self Heal Packages | Fix ByHost Files [ Verify Startup Disk
Files & Processes
Search for file by path: [ Delete if found
Search for file by name: [ Update Locate DB

Spotlight Search:

Search for Process: I Kill if found

Run Command:

((saveas.. ) (schedule..) ( Go )

When the update is complete, quit the application.

Generating a Licensed Software Report

Licensed Software reports allow you to view the following information about the licenses owned
by your organization:

- Number of licenses owned
- Number of licenses in use

«  Computers that have the licenses installed

To generate a Licensed Software report:

Log in to the JSS with a web browser.

Click the Inventory tab.

Click the Licensing link above the search field.

Enter the name of the licensed software object in the search field.

Licensing Inventory

Computers Peripherals Licensing Applications Fonts Plug-ins Mobile Devices Mobile Device Apps

Advaneed Seareh
[Adote cs5:5 Inventory Options
Search Licensing ) Add Licensed Software

Click the Search Licensing button, or type the Enter key.



Generating an Application Usage Report

Application Usage reports go one step beyond license tracking by allowing you to view which
licenses are being used. You can create a computer group based on the results of the report and
use it to reclaim unused licenses.

To generate an Application Usage report:

Log in to the JSS with a web browser.

Click the Logs tab.

Click Application Usage logs.

Use the Reports Starting and Reports Ending pop-up menus to set a date range for the report.

Click the View Usage link across from the licensed software title for which you want to view full
usage details.

ES- |

] & & [ ]

Licensed Software Computer Groups Departments Buildings

Reports Starting: | 6 | ; Jle | ; A 2011-:!

re
-
e
>

Reports Ending: | 7 | i,f‘s [ if‘zml-#!

ar| |4

Licensed Software Title
© Adobe C55.5 View Usage...

To reclaim unused licenses:
Generate an Application Usage report as explained in the previous procedure.

After clicking the View Usage link, click the Unused Licenses tab.
This displays a list of computers that have unused licenses for the product.

Click the Create Computer Group button to create a group that contains these computers.

Create a policy to uninstall Adobe CS5 or CS5.5, and assign the group that you just created as the
scope.

For detailed instructions on creating a policy to uninstall software, see the “Uninstalling Packages”
section in the Casper Suite Administrator’s Guide.
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Creating a Smart Computer Group

Smart computer groups can be used to report on computers that have Adobe CS5/5.5 installed.
They can also be used as the scope for CS5/5.5 update deployments. (For more information, see
the “Deploying an Update-Only Package” section.)

Group membership is updated automatically when computers submit inventory reports to the JSS.

The following instructions explain how to create a smart computer group for computers that have
Adobe CS5/5.5 installed.

To create a smart computer group:

Log in to the JSS with a web browser.

Click the Management tab.

Click the Smart Computer Groups link.

Click the Create Smart Group button.

Enter a name for the group, such as “Adobe CS5.5 Installed”.

In the list of categories, click the Add (+) button across from Software Information.

Edit Smart Computer Group:

ComputerGroup Name: Adobe C55.5 Installed
Send Email Notification on Change: [

Field Search Type Criteria -

Computer Information

Location Information +
Hardware Information +
Storage Information +

05 Configuration Information +
Software Information +
Purchasing Information +
Receipts Information +
Extension Attributes Information +
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7.

8.

9.

Click Licensed Software link in the list of items.

Edit Smart Computer Group: Adobe C55.5 Installed

Search Items
Licensed Software
Application Title
Application Version
Font Title
Fant Version
Plug-in Title
Plug-in Version

Click the Ellipsis (...) button and then click the software title that you plan to update.

Edit Smart Computer Group: Adobe C55.5 Installed

ComputerGroup Name: Adobe C55.5 Installed

Send Email Notification on Change: []

Field Search Type Criteria -
Computer Information
Location Information
Hardware Information

Storage Information

L R S G

0S Configuration Information

Software Information

Licensed Software | has B | ey i

Purchasing Information

Receipts Information

& & * |

Extension Attributes Information

Click the Save button.

24



Updating Adobe CS5 or CS5.5

There are two ways to update Adobe CS5/5.5 products:
« Using an Adobe update server

«  Using update-only packages

This section explains both methods.

Method 1: Deploying Updates Using an Adobe Update
Server

Deploying updates using an Adobe update server allows users to manually install updates as they
become available.

Note: Users must enter administrator credentials to install updates from the Adobe update
server.

Implementing this method involves the following steps:
Set up an internal Adobe update server.

Generate a client configuration file.

Create a client configuration file package.

Upload the client configuration file package to the JSS.
Deploy the client configuration file package.

Verify that the Adobe update server is installed on client computers.

Setting Up an Internal Adobe Update Server

Follow the instructions in the “Setting Up an Update Server: At a Glance” section of the CS5/5.5
Enterprise Deployment Guide to set up an internal Adobe update server.

Generating a Client Configuration File

Follow the instructions in the “Generating Client Configuration Files” section of the C55/5.5
Enterprise Deployment Guide to generate the client configuration file for the Adobe Application
Manager Updater.
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Creating a Client Configuration File Package

Create a package of the client configuration file using Composer.

To create a client configuration file package:

Move the client configuration file that you just generated to the following location:

/Library/Application Support/Adobe/AAMUpdater/1.0/AdobeUpdater.
Overrides

Open Composer and authenticate locally.
Drag the client configuration file to the Sources list in Composer.

When Composer is finished creating the package source, click the Build as DMG button.

008 Composer

B K = Q @
New Package Reveal In Finder Quick Look Delete Search
souRces

» & adobe_prtk ~ [ Application Support
» i AdobeUpdater.over—. ~ [ Adobe
PACKAGES v [ AAMUpdater
v@Lo

% AdobeUpdater.overrides

Owner:
(LT wheel (0) &

Everyone:

| Build as DMG | | Build as PKG |
ot G e N

When prompted, save the package in the desired location.

When Composer is finished building the package, quit the application.

Uploading the Client Configuration File Package

After creating the client configuration file package, upload it to the JSS using Casper Admin.

To upload the client configuration file package:
Open Casper Admin.
Log in using credentials for a JSS administrator account.

Drag the client configuration file package to the Package pane in Casper Admin.
The package may take a few minutes to upload depending on its size.

When the upload is complete, drag the package into a category.
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Save your changes and quit the application.

Deploying the Client Configuration File Package

There are two ways to deploy the client configuration file package:
« Using a policy

+ During imaging

To deploy the client configuration file package using a policy:

Log in to the JSS with a web browser.

Click the Management tab.

Click the Policies link.

Click the Create Policy button.

Select the Install or uninstall a package option and then click Continue.

Follow the onscreen instructions to configure the rest of the policy.
Set the trigger as “every15” and the execution frequency as “Once per computer”.

Computers in the scope execute the policy the next time they check in with the JSS.

To deploy the client configuration file package during imaging:
Open Casper Admin.

Log in using credentials for a JSS administrator account.

Double-click the client configuration file package in the Package pane.
In the Information pane that appears, click the Options tab.

Select the This package must be installed to the boot volume at imaging time checkbox and
click OK.

Drag the client configuration file package from the Package pane to a configuration in the sidebar.

Save your changes and quit the application.

The client configuration file package is deployed the next time you use the configuration to image
computers.

Verifying the Adobe Update Server on the Client Computers

To verify that the Adobe update server is installed on client computers, create an extension
attribute that collects the IP address of the server. This also allows you to ensure that the IP address
of the server is correct.
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10.

To create an extension attribute that collects the IP address of the Adobe update server:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Inventory Options link.

Click the Inventory Collection Preferences link.

Click the Extension Attributes tab.

Click the Add Extension Attribute link.

Enter a name for the extension attribute, such as “Adobe Update Server”.

Choose “Populated by Script” from the Input Type pop-up menu.

Copy the following commands into the Mac OS X Script Contents field:

#!/bin/sh
updaterConfigFile="/Library/Application Support/ Adobe/
AAMUpdater/1.0/AdobeUpdater.Overrides”

if [ -f "$updaterConfigFile" 7;

then result="/bin/cat "$updaterConfigFile" | grep -m 1 "Domain" | sed
-e "'s/<[A>]*>//g" sed 's:http\://::g' | awk '"{print $1}'"

echo "<result>$result</result>"

else echo "<result>No Adobe Update Server Set</result>"

ﬁl

Click OK and then click the Save button.

Client computers scan for and return the IP address of the Adobe update server the next time they
submit inventory to the JSS.

Method 2: Deploying Update-Only Packages

Adobe makes CS5/5.5 updates available from their website at:

http://www.adobe.com/downloads/updates/

Downloading these updates and deploying them in package format allows you to update Adobe
CS5/5.5 products without requiring users to install the updates themselves.

The AAMEE tool allows you to create an update-only package that contains multiple Adobe
CS5/5.5 updates. You can deploy the update-only package using a policy or during imaging.

Deploying an update-only package involves the following steps:

Create an update-only package.
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2.

Upload the update-only package to the JSS.
Deploy the update-only package.

Creating an Update-Only Package

Follow the instructions in the “Creating an Update-Only Package” section of the CS5/5.5 Enterprise
Deployment Guide to create the package.

Uploading the Update-Only Package

After creating the update-only package, upload it to the JSS using Casper Admin.

To upload the update-only package:
Open Casper Admin.
Log in using credentials for a JSS administrator account.

Drag the update-only package to the Package pane in Casper Admin.
The package may take a few minutes to upload depending on its size.

In the Information pane that appears, click the Options tab.

Choose a priority from the Priority pop-up menu.

A priority of 11 is recommended for update-only packages. For more information on priorities, see
the “Managing Packages” section in the Casper Suite Administrator’s Guide.

Configure additional settings as needed and then click OK.

Save your changes and quit the application.

Deploying the Update-Only Package

There are three ways to deploy the update-only package:
« Using a policy
«  During imaging

«  Using Self Service

This guide includes instructions for the first two methods. For instructions on the Self
Service method, see the “Making Policies Available in Self Service” section of the Casper Suite
Administrator’s Guide.

To deploy the update-only package using a policy:

Log in to the JSS with a web browser.
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(Optional) Create a smart computer group that can be used as the scope for the update
deployment.

For more information, see the “Creating a Smart Computer Group” section.
Click the Management tab.

Click the Policies link.

Click the Create Policy button.

Select the Install or uninstall a package option and then click Continue.

Follow the onscreen instructions to configure the rest of the policy.
Set the trigger as “every15” and the execution frequency as “Once per computer”.

Computers in the scope execute the policy the next time they check in with the JSS.

To deploy the update-only package during imaging:
Open Casper Admin.

Log in using credentials for a JSS administrator account.
Double-click the update-only package in the Package pane.

In the Information pane that appears, click the Options tab.

Select the This package must be installed to the boot volume at imaging time checkbox.

Configure additional options as needed and click OK.
Drag the update-only package from the Package pane to a configuration in the sidebar.

Save your changes and quit the application.

The update-only package is deployed the next time you use the configuration to image
computers.
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